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          Adobe Acrobat Reader  
 

Finding Words 
 

You can use the Find command to find a complete word or part of a word in the current PDF 

document.  Acrobat Reader looks for the word by reading every word on every page in the file, 

including text in form fields. 
 

To find a word using the Find command: 
 

1. Click the Find button (Binoculars), or choose Edit > Find. 

2. Enter the text to find in the text box. 

3. Select search options if necessary: 

Match Whole Word Only finds only occurrences of the complete word you enter in 

the box.  For example, if you search for the word stick, the words tick and sticky will 

not be highlighted. 

 

Match Case finds only words that contain exactly the same capitalization you enter in 

the box. 

 

Find Backwards starts the search from the current page and goes backwards through 

the document. 

4. Click Find.  Acrobat Reader finds the next occurrence of the word. 

        

To find the next occurrence of the word, Do one of the following: 

            

            Choose Edit > Find Again  

            Reopen the find dialog box, and click Find Again.  

            (The word must already be in the Find text box.) 

 

Copying and pasting text and graphics to another application 
 

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it 

into another application such as a word processor.  You can also paste text into a PDF 

document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you 

can switch to another application and paste it into another document.   

 

Note:  If a font copied from a PDF document is not available on the system displaying the 

copied text, the font cannot be preserved.  A default font  is substituted. 
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To select and copy it to the clipboard: 

1. Select the text tool T, and do one of the following: 

       To select a line of text, select the first letter of the sentence or phrase and drag to 

       the last letter.   

 

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option 

(Mac OS) as you drag across the width of the document.  

        

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command 

(Mac OS) as you drag the length of the document. 

         

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text 

on the current page is selected.  In Continuous or Continuous – facing mode, most of the text 

in the document is selected.  When you release the mouse button, the selected text is 

highlighted.  To deselect the text and start over, click anywhere outside the selected text.   

The Select All command will not select all the text in the document.  A workaround for this 

(Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected 

text to the clipboard. 

 

2. To view the text, choose Window > Show Clipboard 

 

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the 

Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose 

Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows 

Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK. 
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METROPOLITAN TRANSPORTATION COMMISSION 1 

BAY AREA TOLL AUTHORITY OVERSIGHT COMMITTEE 2 

WEDNESDAY, JULY 8, 2020, 9:35 AM 3 

 4 

AMY R. WORTH, CHAIR: GOOD MORNING, THIS IS AMY WORTH. IT IS MY 5 

PLEASURE TO CONVENE THE MEETING OF THE BAY AREA TOLL AUTHORITY 6 

OVERSIGHT COMMITTEE. I AM CALLING THE MEETING TO ORDER. DUE TO 7 

COVID-19, THIS MEETING WILL BE CONDUCTED AS A ZOOM WEBINAR. 8 

PURSUANT TO THE PROVISIONS OF THE GOVERNOR'S EXECUTIVE ORDER 9 

N-29-20, WHICH SUSPENDS CERTAIN REQUIREMENTS OF THE BROWN ACT. 10 

THIS MEETING WILL BE WEBCAST ON THE MTC WEB SITE. I WILL CALL 11 

UPON COMMISSIONERS, PRESENTERS, STAFF, AND OTHER SPEAKERS BY 12 

NAME AND ASK THAT THEY SPEAK CLEARLY AND RESTATE THEIR NAMES 13 

BEFORE GIVING COMMENTS OR REMARKS. PERSONS PARTICIPATING VIA 14 

ZOOM AND WEBCAST WITH THEIR CAMERAS ENABLED ARE REMINDED THEIR 15 

ACTIVITIES ARE VISIBLE TO VIEWERS. COMMISSIONERS AND MEMBERS 16 

OF THE PUBLIC PARTICIPATING BY ZOOM, WISHING TO SPEAK SHOULD 17 

USE THE RAISED HAND FEATURE OR DIAL STAR NINE AND I WILL CALL 18 

UPON YOU AT THE APPROPRIATE TIME. TELECONFERENCE ATTENDEES 19 

WILL BE CALLED UPON BY THE LAST FOUR DIGITS OF THEIR PHONE 20 

NUMBERS. WE WELCOME ALL PUBLIC COMMENTS ON THE OUR COMMITTEE. 21 

AND IT IS REQUESTED THAT PUBLIC SPEAKERS RESTATE THEIR NAMES 22 

AND ORGANIZATIONS, BUT PROVIDING SUCH INFORMATION IS 23 

VOLUNTARY. MEMBERS OF THE PUBLIC WISHING TO ADDRESS THIS BODY 24 

WERE ASKED TO SUBMIT COMMENTS IN WRITING AT 25 
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INFO@BAYAREAMETRO.GOV. WRITTEN COMMENTS RECEIVED WILL BE 1 

POSTED TO THE ONLINE AGENDA AND ENTERED INTO THE RECORD BUT 2 

WILL NOT BE READ OUT LOUD. IF AUTHORS OF THE WRITTEN 3 

CORRESPONDENCE WOULD LIKE TO SPEAK, THEY ARE FREE TO DO ON THE 4 

REFERENCED AGENDA ITEM OR ANY TOPIC THEY CHOOSE. SPEAKERS 5 

SHOULD RAISE THEIR HAND, AND I WILL CALL UPON THEM AT THE 6 

APPROPRIATE TIME. A ROLL CALL VOTE WILL BE TAKEN FOR ALL 7 

ACTION ITEMS. THE CHAT FEATURE IS ACTIVE, HOWEVER, PLEASE BE 8 

AWARE THAT ANYTHING TYPED INTO THE CHAT WILL BE SUBJECT TO 9 

PUBLIC DISCLOSURE. THE CHAT FEATURE IS NOT AVAILABLE TO 10 

ATTENDEES. IN ORDER TO GET THE FULL ZOOM EXPERIENCE, PLEASE 11 

MAKE SURE YOUR APPLICATION IS UP TO DATE. WITH THAT OUR FIRST 12 

AGENDA ITEM NUMBER ONE IS THE ROLL CALL, AND CONFIRM THE 13 

QUORUM. AND I WOULD LOVE TO TURN TO OUR COMMITTEE CLERK FOR 14 

THE ROLL CALL, PLEASE.  15 

 16 

CLERK OF THE BOARD: GOOD MORNING. BRUINS?  17 

 18 

AMY R. WORTH, CHAIR: GOOD MORNING KIMBERLY.  19 

 20 

JEANNIE BRUINS: PRESENT.  21 

 22 

CLERK OF THE BOARD: DUTRA-VERNACI?  23 

 24 

CAROL DUTRA-VERNACI: PRESENT.  25 
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 1 

CLERK OF THE BOARD: GLOVER?  2 

 3 

SPEAKER: PRESENT.  4 

 5 

CLERK OF THE BOARD: PAPAN?  6 

 7 

GINA PAPAN: HERE.  8 

 9 

CLERK OF THE BOARD: RONEN?  10 

 11 

DIR. HILLARY RONEN: HERE.  12 

 13 

CLERK OF THE BOARD: TAVARES?  14 

 15 

TONY TAVARES: HERE.  16 

 17 

CLERK OF THE BOARD: AND WORTH?  18 

 19 

AMY R. WORTH: HERE.  20 

 21 

CLERK OF THE BOARD: THANK YOU. QUORUM IS PRESENT.  22 

 23 

AMY R. WORTH, CHAIR: THANK YOU VERY MUCH. KIMBERLY I WOULD 24 

LIKE NOW TO INVITE EVERYBODY TO JOIN IN THE PLEDGE OF 25 
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ALLEGIANCE. [ PLEDGE OF ALLEGIANCE ] "I PLEDGE ALLEGIANCE TO 1 

THE FLAG OF THE UNITED STATES OF AMERICA, AND TO THE REPUBLIC 2 

FOR WHICH IT STANDS, ONE NATION UNDER GOD, INDIVISIBLE, WITH 3 

LIBERTY AND JUSTICE FOR ALL."  4 

 5 

AMY R. WORTH, CHAIR: NOW, KIMBERLY MAY I PLEASE TURN BACK TO 6 

YOU FOR THE READING OF THE COMPENSATION ANNOUNCEMENT?  7 

 8 

CLERK OF THE BOARD: YES. AS AUTHORIZED BY STATE LAW I AM 9 

MAKING THE FOLLOWING ANNOUNCEMENT. EACH MEMBER OF THE BOARD 10 

HERE TODAY WILL BE ENTITLED TO RECEIVE $100 PER MEETING 11 

ATTENDED UP TO A MAXIMUM OF $500 PER MONTH PER AGENCY. THIS 12 

AMOUNT IS A PROVIDED AS A RESULT OF CONVENING A MEETING FOR 13 

WHICH EACH MEMBER IS ENTITLED TO COLLECT SUCH AMOUNT.  14 

 15 

AMY R. WORTH, CHAIR: GREAT. THANK YOU VERY MUCH. KIMBERLY. AND 16 

OUR NEXT ITEM IS CONSENT CALENDAR AGENDA ITEM NUMBER FOUR. ARE 17 

THERE ANY ITEMS THAT EITHER THE COMMISSIONER, STAFF, OR 18 

MEMBERS OF THE PUBLIC WOULD LIKE REMOVE FROM THE CONSENT 19 

CALENDAR? LET'S SEE. KIMBERLY, DO I SEE ANYBODY?  20 

 21 

CLERK OF THE BOARD: I HAVE NO RAISED HANDS, AND NO MEMBERS OF 22 

THE PUBLIC WITH RAISED HANDS.  23 

 24 
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AMY R. WORTH, CHAIR: THANK YOU SO MUCH. MAY I PLEASE HAVE A 1 

MOTION AND SECOND TO APPROVE THE CONCEPT CALENDAR?  2 

 3 

GINA PAPAN: PAPAN MOVES.  4 

 5 

JEANNIE BRUINS: BRUINS SECOND.  6 

 7 

AMY R. WORTH, CHAIR: MOVED BY PAPAN. SECOND BY COMMISSIONER 8 

BRUINS. MAY I TURN BACK TO OUR COMMITTEE CLERK FOR THE ROLL 9 

CALL PLEASE.  10 

 11 

CLERK OF THE BOARD: YES. [ROLL CALL] THANK YOU. MOTION PASSES 12 

UNANIMOUSLY.  13 

 14 

AMY R. WORTH, CHAIR: THANK YOU SO MUCH. OUR NEXT ITEM IS ITEM 15 

6A. THIS IS THE -- I -- IS THAT CORRECT? I'M SORRY. I'M 16 

LOOKING AT THE SCRIPT HERE.  17 

 18 

CLERK OF THE BOARD: 5A.  19 

 20 

AMY R. WORTH, CHAIR: WHAT?  21 

 22 

CLERK OF THE BOARD: AGENDA ITEM 5A.  23 

 24 
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AMY R. WORTH, CHAIR: SORRY. GOOD. THANK YOU SO MUCH. MOVED 1 

QUICKLY. ITEM 5A, THE FUNDING AGREEMENT AMENDMENT FOR I80, I 2 

680 STATE ROUTE INTERCHANGE PACKAGE. SOLANO TRANSPORTATION 3 

AUTHORITY IN THE AMOUNT OF $7,100,000, AND I WOULD LIKE TO 4 

TURN TO OUR STAFF MEMBER LISA KLEIN FOR THIS ITEM, PLEASE.  5 

 6 

LISA KLEIN: GOOD MORNING COMMISSIONERS I'M LISA KLEIN WITH 7 

FIELD OPERATIONS AND MANAGEMENT HERE AT BATA MTC, THE PROJECT 8 

THAT CHAIR WORTH MENTIONED IS INTERCHANGE IMPROVEMENTS AT THE 9 

80, 68012 INTERCHANGE PROJECT. THIS PROJECT RECEIVED $53 10 

MILLION IN SENATE BILL ONE TRADE CORRIDORS FUNDS IN 2018 AND 11 

AS PART OF THAT APPLICATION MTC HAD COMMITTED APPROXIMATELY 14 12 

MILLION IN BRIDGE TOLL FUNDS IN ANTICIPATION REALLY OF THE 13 

REGIONAL MEASURE THREE FUNDING, AND THE FACT REGIONAL MEASURE 14 

THREE FUNDING DOES INCLUDE FUNDS FOR THE INTERCHANGE, BUT AS 15 

WE ALL KNOW REGIONAL MEASURE THREE, IN LITIGATION, AND HAS NOT 16 

BEEN AVAILABLE ON THE TIMELINE REQUIRED TO -- FOR THE PROJECT 17 

TO MEET THE MILESTONES NECESSARY TO RETAIN THAT STATE FUNDING. 18 

AS A RESULT, IN JUNE OF 2019, BATA APPROVED A FUNDING 19 

AGREEMENT FOR $7.2 MILLION IN BATA REHAB FUNDS FOR 20 

PRECONSTRUCTION ACTIVITIES TO KEEP THAT PROJECT MOVING ON 21 

SCHEDULE TO AVOID PUTTING STATE FUNDS AT RISK AND NOW THE 22 

PROJECT IS READY TO GO TO CONSTRUCTION. SINCE THE REGIONAL 23 

MEASURE THREE FUNDS REMAIN IN ESCROW BY STATUS POLICY, STAFF 24 

IS REQUESTING TODAY APPROVAL TO AMEND THE FUNDING AGREEMENT TO 25 
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ADVANCE 7.1 MILLION ADDITIONAL DOLLARS IN BATA FUNDING TO 1 

ALLOW THAT PROJECT TO PROCEED TO CONSTRUCTION ON TIME. I WILL 2 

NOTE THE FUNDS HAVE BEEN BUDGETED IN THE FISCAL YEAR 2021 BATA 3 

REHABILITATION BUDGET, AND THE IDEA IS THAT THE ENTIRE 14 4 

MILLION ADVANCE COULD BE REIMBURSED BY REGIONAL MEASURE THREE 5 

TO THE BATA REHAB BUDGET EVENTUALLY, THAT WOULD BE OF COURSE 6 

SUBJECT TO FURTHER COMMISSION ACTION. THAT CONCLUDES MY STAFF 7 

PRESENTATION. HAPPY TO TAKE ANY QUESTIONS.  8 

 9 

AMY R. WORTH, CHAIR: GREAT LISA THANK YOU SO MUCH. FIRST ARE 10 

THERE ANY COMMISSIONER QUESTIONS? OKAY. ANY MEMBERS OF THE 11 

PUBLIC THEN WHO WOULD LIKE TO COMMENT ON THIS ITEM?  12 

 13 

CLERK OF THE BOARD: NO RAISED HANDS AND WE HAVE NO WRITTEN 14 

PUBLIC COMMENTS FOR THIS ITEM.  15 

 16 

AMY R. WORTH, CHAIR: ALL RIGHT. KIMBERLY, THANK YOU SO MUCH. 17 

I'LL BRING IT BACK TO THE COMMITTEE HAD. AND FIRST OF ALL I'LL 18 

ASK DO I HAVE A MOTION AND SECOND TO APPROVE THE FUNDING 19 

AGREEMENT?  20 

 21 

DIR. HILLARY RONEN: MOTION RONEN.  22 

 23 

GINA PAPAN: SECOND PAPAN.  24 

 25 
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AMY R. WORTH, CHAIR: MOTION RONEN. SECOND PAPAN. ANY FURTHER 1 

DISCUSSION? ALL RIGHT. KIMBERLY, I WOULD LOVE TO TURN BACK TO 2 

YOU FOR ROLL CALL FOR THIS ITEM.  3 

 4 

CLERK OF THE BOARD: OF COURSE. [ROLL CALL] THANK YOU. MOTION 5 

PASSES UNANIMOUSLY.  6 

 7 

AMY R. WORTH, CHAIR: THANK YOU SO MUCH. OUR NEXT ITEM IS 8 

AGENDA 5B CONTRACT AMENDMENT FOR TOLL FACILITIES MAINTENANCE 9 

ECONOLIGHT SYSTEMS, INC. IN AN AMOUNT OF $10,500,000 ANGELA 10 

LOUIE WILL PRESENT THIS. LOVE YOUR BACKGROUND THERE.  11 

 12 

ANGELA LOUIE: THANK YOU SO MUCH. GOOD MORNING MY NAME IS 13 

ANGELA LOUIE WITH BATA STAFF. THIS MORNING I'M PRESENTING A 14 

CONTRACT AMENDMENT FOR TOLL FACILITIES MAINTENANCE WITH 15 

ECONOLIGHT SYSTEMS, INC. IN SUMMER OF 2017 AFTER A COMPETITIVE 16 

PROCUREMENT BATA ENTERED INTO A CONTRACT WITH ECONOLIGHT 17 

FORMERLY EJIS, ITS FOR EQUIPMENT AND INFRASTRUCTURE ON THE 18 

STATE AREA TOLL FACILITIES. ONE OF THE KEY COMPONENTS OF 19 

ASSESSMENTS IS PREVENTATIVE MAINTENANCE EARLY ON SO THIS 20 

CONTRACT ALLOWS US TO PERFORM PREVENTIVE MAINTENANCE AND CATCH 21 

THINGS BEFORE THEY BECOME BIGGER AND PREVENTS COSTS IN THE 22 

FUTURE. $10.5 MILLION CONTRACT AMENDMENT BREAKS DOWN INTO 23 

$45,000 PER MONTH FOR RECURRING MONTHLY MAINTENANCE AND SPARE 24 

THE AIR PARTS PLUS ABOUT $246,000 PER MONTH FOR TASK ORDER 25 
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WORK, WHICH INCLUDES RECURRING, CORRECTIVE, AS NEEDED, AND 1 

EMERGENCY WORK. AND IT ALSO GIVES US THE FLEXIBILITY TO 2 

PERFORM UNANTICIPATED REPAIRS. SOME OF THE TASK WORK WILL BE 3 

FOR REGIONAL MEASURE THREE SIGNAGE AND PARTICIPATION FOR 4 

ELECTRONIC TOLLING. TEAM HAS BEEN PERFORMING THIS WORK SINCE 5 

2011 AND STAFF HAS BEEN HAPPY WITH ECONOLIGHT'S PERFORMANCE. 6 

MANAGING AND PRIORITIZING CONTRACTS WHILE MINIMIZING COST TO 7 

BATA. UNDERSTANDING BATA'S PARTNERSHIP WITH CALTRANS BECAUSE 8 

ECONOLIGHT HAS SUCCESSFULLY PERFORMED MAINTENANCE FACILITIES 9 

AT THE TOLL, THREE ADDITIONAL YEARS IN AN AMOUNT NOT TO EXCEED 10 

$10.5 MILLION. THANK YOU. I WOULD BE HAPPY TO ANSWER ANY 11 

QUESTIONS.  12 

 13 

AMY R. WORTH, CHAIR: THANK YOU VERY MUCH. FIRST LET ME TURN TO 14 

THE COMMITTEE TO SEE IF YOU HAVE ANY QUESTIONS. OKAY THEN I 15 

WOULD LIKE TO TURN TO OUR COMMITTEE CLERK. IS THERE ANY PUBLIC 16 

COMMENT ON THIS ITEM?  17 

 18 

CLERK OF THE BOARD: I HAVE RECEIVED NO -- ONE WRITTEN PUBLIC 19 

COMMENT FROM ALETA DUPREE AND THERE IS ONE RAISED HAND FROM 20 

THE MEMBERS OF THE PUBLIC. STUART JAMES.  21 

 22 

AMY R. WORTH, CHAIR: OKAY TURNING TO STUART JAMES. WE WELCOME 23 

YOUR COMMENTS.  24 

 25 
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SPEAKER: YES. HI. HOW ARE YOU? FIRST OF ALL, FIRST I WOULD 1 

LIKE TO SAY I WAS A BIT LOST IN THIS MEETING BECAUSE IT'S NOT 2 

CAPTIONED FOR THE HEARING IMPAIRED AND WAS ONLY INFORMED OF 3 

THE MEETING AND THAT SHOULD BE ADDRESSED BUT PROBABLY FOR 4 

ANOTHER TIME. I WOULD LIKE TO THANK THE MTC PROGRAMMING AND 5 

ALLOCATION COMMITTEE MEMBERS. AGAIN MY NAME IS STUART JAMES I 6 

AM THE EXECUTIVE DIRECTOR FOR CENTER FOR INDEPENDENT LIVING, 7 

AND I AM HERE TO SPEAK TO ITEM 4B ON YOUR AGENDA. IF YOU ARE 8 

FAMILIAR WITH THE CENTER FOR INDEPENDENT LIVING THE CENTER 9 

PROVIDES ADVOCACY AND SERVICES THAT CREATES AWARENESS, 10 

COLLABORATION AND OPPORTUNITY AMONG PEOPLE WITH DISABILITY IN 11 

THE COMMUNITY AT LARGE. IN MANY CASES, A PRESENT DISABILITY 12 

CAN MAKE IT DIFFICULT TO DRIVE AN AUTOMOBILE AND IN OTHER CASE 13 

IT IS CAN BE SIMPLY COST PROHIBITIVE. COST CAN BE UPWARDS OF 14 

$70,000 TO PURCHASE AND SO A SIGNIFICANT NUMBER OF PEOPLE WITH 15 

DISABILITY, RELY EXCLUSIVELY ON PUBLIC TRANSPORTATION DURING 16 

THEIR DAILY LIVES. -- REDUCED FARES TO ACCOMMODATE -- AND THE 17 

COUNTY WOULD HAVE LOST SALES TAX REVENUES AS A RESULT OF SHUT 18 

DOWN. IT APPEARS AS -- STRUGGLING TO MAINTAIN SERVICE AS A 19 

RESULT AND THERE IS FINANCIAL CHALLENGES SHOWING NO SIGNS OF 20 

IMPROVING IN THE COMING MONTHS. WE BELIEVE THE 33.8 MILLION 21 

THAT IS BEING PREPARED FOR MTC TO ALLOCATE TO AC TRANSIT WILL 22 

HELP THEM CONTINUE TO PROVIDE THE LIFELINE SERVICE THAT SO 23 

MANY PEOPLE WITH DISABILITIES RELY ON TO GET TO THE GROCERY 24 

STORE, MAKE MEDICAL APPOINTMENTS OR COMMUTE TO THEIR CENTRAL 25 
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SERVICES JOBS. IF TRANSIT DOES NOT RECEIVE THE FUNDING WE FEEL 1 

THIS WILL HAVE TO REDUCE SERVICES AND PEOPLE WITH DISABILITIES 2 

WILL BE -- OR -- YOU MAY ALSO RELY ON PUBLIC TRANSPORTATION 3 

WILL NOT BE ABLE TO GET THERE. THANK YOU, AGAIN, AND --  4 

 5 

AMY R. WORTH, CHAIR: STUART --  6 

 7 

SPEAKER: IN THE FUTURE, I HOPE WE ALSO ADDRESS THE CAPTION.  8 

 9 

AMY R. WORTH, CHAIR: STUART THANK YOU FOR YOUR COMMENTS AND 10 

THANK YOU FOR THE FINE WORK OF CIL, I GO WAY BACK TO ITS 11 

FOUNDING ALONG WITH DORENE GIOCAPINI BUT I WANT TO SAY WE'LL 12 

FOLLOW UP TODAY WITH OUR STAFF REGARDING PROVIDING FOR THE 13 

HEARING IMPAIRED FACILITIES FOR OUR MEETINGS. SO THANK YOU SO 14 

MUCH FOR POINTING THAT OUT. WE -- I THINK YOUR COMMENTS MAY BE 15 

DIRECTED TO OUR MEETING LATER IN THE MORNING. -- WHERE WE WERE 16 

GOING TO BE DISCUSSING THE RELIEF FUNDS TO THE TRANSIT 17 

AGENCIES. SO FEEL FREE TO STICK AROUND, AND REPEAT YOUR 18 

COMMENTS AT THAT COMMITTEE MEETING ALSO WHEN IT COMES FORWARD. 19 

SO, THANK YOU SO MUCH. SO OUR NEXT SPEAKER IS AMY SERGEANT.  20 

 21 

SPEAKER: HELLO. IS THERE A -- AN ESTIMATED TIME ON WHEN YOU 22 

WILL BE TALKING ABOUT ALLOCATION OF FUNDS TO VTA?  23 

 24 
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AMY R. WORTH, CHAIR: YOU KNOW, IT'S HARD TO GUESS, THE 1 

MEETINGS ARE NOTICED AS THEY ARE. I WOULD -- IT'S DIFFICULT TO 2 

PREDICT. SO WE HAVE COMMIT FINISHING THIS COMMITTEE AND THEN 3 

WE HAVE ANOTHER COMMITTEE BEFORE THE PROGRAMMING AND 4 

ALLOCATIONS COMMITTEE SO THAT'S THE THIRD COMMITTEE OF THE 5 

MORNING. SO JUST STICK WITH US, AND WE'LL GET THERE SOON.  6 

 7 

SPEAKER: [LAUGHTER]  8 

 9 

AMY R. WORTH, CHAIR: SORRY. I CAN'T GIVE YOU MORE INFORMATION 10 

THAN THAT.  11 

 12 

SPEAKER: NO THAT'S IT THANK YOU.  13 

 14 

AMY R. WORTH, CHAIR: OKAY. ARE THERE ANY OTHER MEMBERS OF THE 15 

PUBLIC THAT WOULD LIKE TO SPEAK ON THIS ITEM? OKAY. I WOULD 16 

LIKE TO BRING IT BACK TO THE COMMITTEE FOR COMMITTEE 17 

DISCUSSION AND DECISIONS. ARE THERE ANY COMMENTS? OR I WOULD 18 

ENTERTAIN A MOTION TO APPROVE ITEM 5B.  19 

 20 

CAROL DUTRA-VERNACI: APPROVAL OF ITEM 5B IF NOBODY HAS 21 

COMMENT.  22 

 23 

FEDERAL D. GLOVER: I'M SECOND IT.  24 

 25 
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AMY R. WORTH, CHAIR: MOTION BY DUTRA-VERNACI AND SECOND BY 1 

COMMITTEE MEMBER GLOVER. ROLL CALL PLEASE.  2 

 3 

CLERK OF THE BOARD: [ROLL CALL] THE MOTION PASSES UNANIMOUSLY.  4 

 5 

AMY R. WORTH, CHAIR: THANK YOU VERY MUCH. ITEM 5A A 6 

RECOMMENDATION -- EXCUSE ME. ITEM 5C RECOMMENDATION OF 7 

CONTRACT ACTIONS FOR THE BAY AREA TOLL AUTHORITY. SO I BELIEVE 8 

THAT ANDY FREMIER IS ON THIS REPORT. ANDY MAY I TURN TO YOU 9 

PLEASE?  10 

 11 

ANDREW FREMIER: THANK YOU CHAIR WORTH GOOD MORNING 12 

COMMISSIONERS ANDREW FREEDOM EAR DEPUTY DIRECTOR OF OPERATIONS 13 

AT BAY AREA TOLL AUTHORITY. I THINK WE HAVE A PRESENTATION. 14 

THANK YOU. THIS ITEM IS A CONTINUATION OF THE STATUS UPDATE OF 15 

THE TOLL SYSTEM ENVIRONMENT AND THE PLANS TO MOVE FORWARD TO 16 

PROTECT THE TOLL REVENUE STREAM PRIMARILY DUE TO THE PANDEMIC. 17 

THERE IS FOUR SPECIFIC ACTIONS IN THIS REQUEST, AND THEY'RE 18 

DESIGNED TO PROTECT THE TOLL REVENUE AND ALLOW US TO NAVIGATE 19 

MORE SUCCESSFULLY IN THE EVENT THE TOLL COLLECTORS DON'T COME 20 

BACK SOON OR THEY DON'T COME BACK AT ALL. FRANKLY, THEY ALSO 21 

COULD BE FORCED TO LEAVE AGAIN DEPENDING ON THE CONDITIONS OF 22 

THE ENVIRONMENT. THESE STEPS ARE ALSO IMPORTANT THOUGH AS AN 23 

INVESTMENT FOR THE FUTURE MOVE TO A COMPLETE ALL ELECTRONIC 24 

TOLLING SYSTEM. SO WE DO THINK IT'S A GOOD INVESTMENT UNDER 25 
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ALL CIRCUMSTANCES. I WILL MENTION THAT WE WORK VERY CLOSELY 1 

WITH CALTRANS AND ARE PHYSICALLY READY TO MOVE THE TOLL 2 

COLLECTORS BACK INTO POSITION. WE HAVE MODIFIED THEIR WORK 3 

ENVIRONMENT AND WE HAVE GOT SOME WORK PROTOCOLS SET IN PLACE, 4 

BUT IT'S OUR UNDERSTANDING THAT BECAUSE OF THE CURRENT COVID 5 

CONDITIONS, AND THE RETURN OF SOME OF THE SITUATIONS THAT HAVE 6 

CAUSED THE PROBLEM IN THE FIRST PLACE. THE STATE WOULD LIKE TO 7 

TAKE SOME TIME BEFORE DECIDING IF THE TOLL COLLECTORS SHOULD 8 

COME BACK. NEXT SLIDE PLEASE. JUST AS A REMINDER, HERE IS SOME 9 

OF THE TIMELINES THAT WE HAVE GONE THROUGH DURING THE COURSE 10 

OF THIS DISCUSSION. BACK IN 2013 THE GOLDEN GATE BRIDGE MADE 11 

THE MOVE TO ALL ELECTRONIC TOLLING, AND THEN AS LATE AS 2018, 12 

THE BATA OVERSIGHT COMMITTEE APPROVED OUR PLANS FOR MOVING 13 

FORWARD FOR A TRANSITION THAT WOULD TAKE MULTIPLE YEARS TO 14 

CONVERT. IDEA WAS TO START IN 2022, AND THEN FINISH WITH THE 15 

BAY BRIDGE IN THE '25 OR '26 TIME ERA. OBVIOUSLY ON MARCH 21ST 16 

THE ENVIRONMENT CHANGED FOR US AND THE COLLECTORS THEMSELVES 17 

ARE CALTRANS EMPLOYEES AND IN THE DIRECTION OF THE STATE THEY 18 

WERE ASKED TO BE REMOVED FOR PUBLIC SAFETY BOTH FOR THEM AND 19 

THE TRAVELING PUBLIC. AND SO WE MOVED INTO A TERM THAT WE CALL 20 

CASHLESS COLLECTION ON MARCH 21ST, AND THIS'S CURRENTLY WHERE 21 

WE'RE AT. AND WE'RE TRYING TO PUT IN PROTECTIONS THAT REALLY 22 

ALLOW US A MUCH BETTER CHANCE OF COLLECTING THE REVENUE THAT'S 23 

SO IMPORTANT TO THE REGION. NEXT SLIDE PLEASE. SO A LITTLE BIT 24 

OF A REMINDER ON HOW THINGS HAVE CHANGED FOR FOLKS THAT 25 
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ANTICIPATED TO PAY CASH AS THEY CAME TO THE PLAZAS. ON THE 1 

LEFT YOU SEE WHAT IS CALLED THE TRADITIONAL TOLLING APPROACH 2 

WHERE YOU ESCALATE VIOLATIONS FOR FOLKS THAT DRIVE-THRU 3 

WITHOUT PAYING. THERE IS A 25 PERCENT FIRST NOTICE, $25 FIRST 4 

NOTICE ADD A SECOND NOTICE IT BECOMES A $70 PENALTY AND 5 

EVENTUALLY WE GET TO HOLDS. DURING CASHLESS COLLECTION WE HAVE 6 

DECIDED TO HOLD OFF ON THE PENALTY ESCALATION AND DMV HOLDS WE 7 

BELIEVE WE HAVE PROTECTED THE INTEREST OF BATA AS BEST WE CAN 8 

AND SO WE DO ANTICIPATE AT SOME POINT REINSTATING THAT 9 

PROCESS, BUT FOR NOW, WE ARE REALLY JUST TRYING TO COLLECT THE 10 

TOLL REVENUE, BUT IT IS A MUCH MORE DIFFICULT SITUATION FOR US 11 

TODAY, BECAUSE WE HAVE TO CHASE A LOT OF THE REVENUE THAT WAS 12 

PREVIOUSLY PAID FOR IN CASH. NEXT SLIDE PLEASE. WE HAVE VERY 13 

SIMPLE GOALS. OBVIOUSLY WE'RE TRYING TO COLLECT THE TOLLS AND 14 

PROTECT THE PUBLIC. WE WANT TO MAKE SURE THAT WE MINIMIZE THE 15 

RISK, BOTH GOING FORWARD AND IN OUR CURRENT CONDITIONS, AND 16 

THEN WE ALSO NEED TO PRESERVE ALTERNATIVES FOR FOLKS THAT DO 17 

WANT TO PAY CASH BUT WE WOULD LIKE TO AVOID HAVING THEM PAY 18 

CASH AT THE TOLL BOOTHS THEMSELVES. SO THAT DOES REQUIRE 19 

THOUGH A SYSTEM OF CHANGES. AND THE WE WILL BE BACK IN THE 20 

FALL TO TALK ABOUT SOME OF THE TOLL POLICY CHANGES THAT WE'LL 21 

BE REQUIRING TO BATA RESOLUTION. WE'RE HERE NOW TALKING MOST 22 

PRIMARILY ABOUT THE TOLL FACILITIES AND SYSTEM IMPROVEMENTS 23 

THAT NEED TO TAKE PLACE TO ENSURE THAT WE'RE READY AND JUST A 24 

REMINDER THAT WHAT WE REALLY DO IN THE ALL ELECTRONIC 25 
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ENVIRONMENT IS YOU MOVE COLLECTION FROM THE BOOTH TO THE BACK 1 

OFFICE. AND SO WE DO NEED TO INCREASE OUR ROLE IN CUSTOMER 2 

SERVICE EFFORTS AT THE CUSTOMER SERVICE CENTER AND THAT ALSO 3 

IS A PRIMARY GROWTH AREA THAT IS CURRENTLY A REAL CHALLENGE IN 4 

THIS ENVIRONMENT THAT WE'RE IN. NEXT SLIDE. THERE IS MORE 5 

DETAIL AFTER THIS, BUT IN GENERAL, WE'RE IN PHASE ONE RIGHT 6 

NOW, AND SO WE'RE SPENDING 2020, REALLY GETTING READY FOR 7 

UPGRADES IN THE CUSTOMER SERVICE ENVIRONMENT, SO THAT THE 8 

CUSTOMER SERVICE CENTER CAN HANDLE THE INCREASED LOAD OF 9 

TRANSACTIONS. WE NEED TO BE READY, OPERATIONALLY, TO PROTECT 10 

THE TOLL REV NEW FINANCES TO MAKE SURE THEY'RE IN GOOD SHAPE. 11 

WE HAVE ALSO GOT TO DO QUITE A BIT OF OUTREACH TO MAKE SURE 12 

PEOPLE UNDERSTAND THE CHANGES. THERE NEED TO BE ENGINEERING 13 

CHANGES IN THE PLAZAS AND WE HAVE TO DEAL WITH THE EMPLOYEES 14 

THAT ARE CURRENTLY COLLECTING CASH IN THE BOOTH IN THE NORMAL 15 

ENVIRONMENT. OVER THE NEXT COUPLE OF YEARS, WE'LL BE BACK 16 

TALKING ABOUT MORE IMPROVED WAYS TO DEAL WITH THE FINANCIAL 17 

REPORTING, AND ALSO CONTINUED IMPROVEMENTS TO A CASH NETWORK 18 

THAT ALLOWS THE UNBANKED TO BE ABLE TO PLAY, TO PAY 19 

SEAMLESSLY. AND THEN WE DO HAVE LONG-TERM PLANS TO REALLY 20 

MODIFY THE TOLL PLAZAS'S CONSIDERABLY TO REMOVE THE OBVIOUS 21 

WHICH IS THE TOLL BOOTH ITSELF. BUT THAT WORK WILL HAPPEN MUCH 22 

MORE MANAGEABLY DOWN THE ROAD AND IS A CONSIDERATION FOR 23 

FUTURE BUDGETS NOT TODAY AND NOT IN THE NEAR TERM. NEXT SLIDE 24 

PLEASE. SO IN MORE DETAIL WHAT WE'RE TRYING TO STAND UP THIS 25 
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YEAR, IS AN ALIGNMENT WITH WHAT THE GOLDEN GATE BRIDGE DOES 1 

TODAY IN THEIR ALL ELECTRONIC ENVIRONMENT. SO THEY SEND AN 2 

INVOICE FOR A TOLL ONLY FIRST BEFORE THEY MOVE ON TO THE 3 

ESCALATION PROCESS. AS YOU CAN SEE, WE DON'T DO THAT TODAY, 4 

BECAUSE WE DON'T HAVE THE ABILITY TO BUNDLE TRANSACTIONS, 5 

WHICH MEANS IF YOU GO THROUGH DAY, YOU GET A PIECE OF MAIL, IF 6 

YOU GO THROUGH THE NEXT DAY YOU GET ANOTHER PIECE OF MAIL. 7 

GOLDEN GATE IS ABLE TO PUT THOSE TRANSACTIONS TOGETHER AND 8 

BILL YOU ON A REGULAR CYCLE, WHICH IS WHERE WE WOULD LIKE TO 9 

GET TO. EVENTUALLY, WHEN WE GET TO ALL ELECTRONIC TOLLING WE 10 

WOULD MIMIC THE EXISTING SYSTEM OF GOLDEN GATE YOU JUST ADD AN 11 

ADDITIONAL INVOICE WHICH IS THE ISSUE BEFORE US TODAY. I 12 

MENTIONED CUSTOMER SERVICE UPGRADES IT'S QUITE A TRANSACTION 13 

IN ORDER -- OR TRANSITION IN ORDER TO MOVE THE COLLECTORS FROM 14 

THE BOOTHS TO THE BACK OFFICE. THOSE WILL GROW AND THERE IS A 15 

LOT MORE WORK THAT HAS TO BE DONE ON THE BACK END TO COLLECT 16 

THE REVENUE FROM THOSE INVESTMENTS, AND CLEARLY THERE IS ALL 17 

KINDS OF PUBLIC RELATIONS UPDATES IN TERMS OF THE WEB SITE AND 18 

OTHER CUSTOMER SERVICE ENVIRONMENT IMPROVEMENTS. NEXT SLIDE. 19 

TRANSACTIONS THAT WE RECEIVED TODAY IN CASH REALLY CHALLENGE 20 

THE PROCESS AND THE MAJOR INVOICING THAT WOULD BE REQUIRED, 21 

THIS PIE CHART REALLY DESCRIBES HOW WE ANTICIPATE USING THE 22 

EXPERIENCE THAT THE GOLDEN GATE BRIDGE HAS SEEN PLUS WHAT WE 23 

HAVE SEEN AROUND THE NATION PLUS WHAT WE SEE WILL HAPPEN 24 

AROUND THE TRANSACTIONS WE ANTICIPATE TRAVEL OF THE 25 
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TRANSACTIONS WILL BE COMING FROM FASTRAK CUSTOMERS WE SEE 1 

THERE WILL BE OPTIONS TO PAY BY LICENSE PLATE SO YOU CAN DO IT 2 

INDIVIDUALLY AS I TRANSPORT ACROSS THE BRIDGES BUT WE DO 3 

ANTICIPATE QUITE A BIT OF INVOICING. SO ABOUT A QUARTER OF THE 4 

TRANSACTIONS WOULD COME THROUGH INVOICING AND THEN OF COURSE 5 

WE CONTINUE TO HAVE TO RESOLVE IMAGE REJECTIONS AND OTHER 6 

TECHNICAL THINGS THAT HAPPEN DURING THE TOLL TRANSACTION. SO 7 

THIS INFORMATION HAS BEEN VALIDATED BY MOST OF THE WORK THAT'S 8 

BEING DONE IN THIS ENVIRONMENT ACROSS THE NATION AND IT'S WHAT 9 

WE NEED TO PREPARE FOR. NEXT SLIDE. NEXT SLIDE PLEASE. YEAH. 10 

SO THE PUBLIC OUTREACH CAMPAIGN, I THINK, IS PRETTY OBVIOUS. 11 

WE WANT TO SET UP PAYMENT OPTIONS FOR FASTRAK ACCOUNTS THE 12 

GOLDEN GATE BRIDGE USES LICENSE PLATE ACCOUNTS FOR ONE TIME 13 

PAYMENTS SO WE NEED TO GET THAT INFORMATION OUT TO MAKE SURE 14 

THAT PEOPLE KNOW HOW TO PAY AND ALL THE DIFFERENT WAYS THAT 15 

THEY CAN PAY, BUT OF COURSE THE BEST SOLUTION FOR ALL OF US IS 16 

IF THEY JOIN FASTRAK WHICH IS THREE. NEXT SLIDE. NEXT PLAZA 17 

TOLL IMPROVEMENTS. WE DON'T ANTICIPATE SIGNIFICANT 18 

IMPROVEMENTS THAT WILL BE NECESSARY TO MOVE TO A MORE CASHLESS 19 

ENVIRONMENT. I THINK WE KNOW THE PLAZA OPERATES REASONABLY 20 

WELL TODAY IN THE CASHLESS ENVIRONMENT. BUT WE ANTICIPATE 21 

SIGNAGE CHANGES, STRIPING CHANGES AND OTHER DETAILS THAT 22 

AFFECT THE WAY TRANSPORTATION APPROACHES THE TOLL PLAZA. SO WE 23 

WORK CLOSELY WITH CALTRANS AND MAKE THE MINOR IMPROVEMENTS 24 

THAT WE THINK ARE NECESSARY TO REALLY FACILITATE THE TOLL 25 
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TRANSACTION AND MOVEMENT ACROSS THE BRIDGE PLAZA WHILE WE WAIT 1 

FOR THE LARGER IMPROVEMENTS TO COME A COUPLE OF YEARS FROM 2 

NOW. NEXT SLIDE. ONE OF THE BIGGER CHALLENGES IN FRONT OF US 3 

IS WORKING WITH THE STATE OF CALIFORNIA TO TRANSITION THE 4 

EMPLOYEES PROPERLY. SO WE HAVE BEEN WORKING CLOSELY WITH THE 5 

SACRAMENTO ADMINISTRATIVE FOLKS AND IT IS CONSISTENT WITH THE 6 

CURRENT SEIU AGREEMENTS THAT ARE IN PLACE WITH THE COLLECTORS 7 

BUT THERE IS QUITE A BIT OF NOTICE REQUIREMENTS AND WE DO FEEL 8 

AN OBLIGATION TO MAKE SURE THERE IS AN OPPORTUNITY TO RETRAIN 9 

COLLECTORS TO OTHER PROFESSIONS INCLUDING POTENTIALLY MOVING 10 

TO OUR BACK OFFICE ENVIRONMENT. THE CALTRANS IS ALSO COMMITTED 11 

TO BEING ABLE TO ABSORB ALL OF THE EMPLOYEES BACK INTO THE 12 

WORK ENVIRONMENT IS THERE MIGHT BE SOME OPPORTUNITIES FOR 13 

FOLKS TO RETIRE A LITTLE BIT EARLY AND WE'LL CONTINUE TO WORK 14 

ON THOSE KINDS OF PLANS WITH CALTRANS OVER THE COMING MONTHS. 15 

BUT WE DO BELIEVE THAT THERE ARE SOME REALLY GOOD 16 

OPPORTUNITIES FOR THESE EMPLOYEES WHO HAVE SERVED WELL OVER 17 

THE YEARS. NEXT SLIDE. SO, IN CONCLUSION, I JUST WANTED TO 18 

SHOW YOU WHAT OUR CURRENT THINKING IS IN TERMS OF TIMELINE. SO 19 

IN MAY AND JUNE YOU APPROVED SOME WORK FOR US TO GET STARTED 20 

ON THE INVOICING AND THAT WORK IS UNDERWAY WITH CONDUENT. ONE 21 

REMINDER IS WE'RE PLANNING ON OPENING THREE MAJOR EXPRESS 22 

LANES OVER THE COURSE OF THIS TIME PERIOD AND SO WE'RE VERY 23 

MINDFUL OF MAKING SURE THAT THE WORK THAT IS BEING DONE BY 24 

CONDUENT IS SEQUENCED PROPERLY AND RESOURCED PROPERLY AND THIS 25 
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WILL BE A CONTINUING CHALLENGE THAT WE WILL REPORT BACK OVER 1 

THE COURSE OF THE FALL BUT WE BELIEVE WITH THE CHANGE ORDERS 2 

THAT YOU HAVE AUTHORIZED BEFORE AND WITH THE ANTICIPATION THAT 3 

YOU WILL AUTHORIZE THESE TODAY, WE'LL BE WELL UNDERWAY TO BE 4 

ABLE TO INVOICE PROPERLY BY THE END OF THE CALENDAR YEAR AND 5 

REALLY CONCENTRATE ON IMPROVEMENTS BEYOND THAT TO GET US TO A 6 

TRUE ALL ELECTRONIC ENVIRONMENT. SO, TODAY, WHAT WE'RE GOING 7 

TO DO IS WHAT WE'RE ASKING FOR IS FOUR PARTICULAR ACTIONS. WE 8 

WOULD LIKE TO AWARD A CONTRACT CHANGE ORDER TO OUR CONDUENT 9 

BACK OFFICE CONTRACTOR TO ALLOW THEM TO CONTINUE TO DEPLOY THE 10 

INVOICING METHODS AND TESTING. THERE IS ALSO AN ANTICIPATION 11 

OF ADDITIONAL TRANSACTION CHARGES WHICH ARE ANTICIPATED IN THE 12 

CONTRACT, BUT WERE NOT FUNDED DIRECTLY, BECAUSE WE HAVE HAD NO 13 

KNOWLEDGE OF WHEN WE WOULD TRANSITION TO ALL ELECTRONIC 14 

TOLLING. SO THE BULK OF THE CHANGE ORDER IS REALLY ASSOCIATED 15 

WITH THE OPERATIONAL COST THAT WILL HAPPEN OVER THE COURSE OF 16 

THE NEXT YEAR OR TWO. DEVELOPMENT, AND TESTING COST IS A MINOR 17 

PORTION OF THAT $10 MILLION CHANGE. WE'LL ALSO NEED TO 18 

PURCHASE A LOT MORE TOLL TAG. AGAIN YOU HAVE EXISTING 19 

CONTRACTS IN PLACE THAT WILL ALLOW US TO PURCHASE TOLL TAGS 20 

WE'RE ASKING TO ACCELERATE THOSE PURCHASES TODAY. WE'RE ALSO 21 

STARTING CUSTOMER OUTREACH DEVELOPMENT AND GETTING THAT WORK 22 

STARTED. FINALLY THERE IS A SMALL AMOUNT OF CIVIL WORK IN THIS 23 

CASE ON THE SOUTHERN BRIDGES YOU HAVE AUTHORIZED ENGINEERING 24 

WORK ON THE NORTHERN BRIDGES AND THIS IS REALLY DESIGNED TO 25 
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MAKE SURE THE OPERATION IS SEAMLESS FOR THE TRAVELING PUBLIC 1 

AS THEY GO THROUGH. WE DO ANTICIPATE POTENTIALLY BEING BACK IN 2 

AUGUST WITH SOME OTHER CONTRACT ACTIONS. BUT RIGHT NOW WE 3 

ANTICIPATE NOT COMING BACK 19 UNTIL THE FALL WHEN WE'LL START 4 

TALKING ABOUT POLICY CHANGES AND OPTIONS FOR HOW WE CAN 5 

GENERATE THE TOLLING INVOICE PROPERLY AND NOTICE IT PROPERLY. 6 

SO WITH THAT STAFF RECOMMENDS THAT THE COMMITTEE AUTHORIZE THE 7 

EXECUTIVE DIRECTOR OR DESIGNEE TO NEGOTIATE AND ENTER INTO THE 8 

FOLLOWING. CONTRACT CHANGE ORDER WITH CONDUENT NOT TO EXCEED 9 

$10.5 MILLION TO MODIFY THE CUSTOMER SERVICE CENTER AND 10 

OPERATIONS SUPPORT. WE WOULD ALSO LIKE A CONTRACT AMENDMENT 11 

WITH CARIBOU PUBLIC RELATIONS IN AN AMOUNT NOT TO EXCEED 12 

$990,000 FOR PUBLIC OUTREACH AND EDUCATION SERVICES. WE WOULD 13 

ALSO LIKE A PURCHASE ORDER WITH NEOLOGY, NOT TO EXCEED $2.81 14 

MILLION FOR FASTRAK TOLL TAGS, ALL SWITCHABLE TAGS THAT WE'RE 15 

GIVING TO ALL CUSTOMERS, AND THEN FINALLY A CONTRACT AMENDMENT 16 

WITH A COM FROM OUR BENCH OF CONTRACTORS NOT TO EXCEED 17 

$250,000 FOR CIVIL DESIGN SERVICES TO SUPPORT THAT TRANSITION. 18 

AND WITH THAT I WOULD BE HAPPEN TO ANSWER ANY QUESTIONS.  19 

 20 

AMY R. WORTH, CHAIR: THANK YOU VERY MUCH ANDY. I SEE NICK. I 21 

WANT TO TURN TO THE COMMITTEE --  22 

 23 

COM. NICK JOSEFOWITZ: CHAIR --  24 

 25 
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AMY R. WORTH, CHAIR: I WOULD LIKE TO FIRST TURN TO 1 

COMMISSIONER JOSEFOWITZ.  2 

 3 

COM. NICK JOSEFOWITZ: THANK YOU CHAIR WORTH. ACTUALLY I SHOULD 4 

HAVE DONE THIS IN THE BEGINNING OF THE ITEM OF THE 5 

PRESENTATION. BUT I HAVE TO RECUSE MYSELF FROM THIS ITEM 6 

BECAUSE OF A CONFLICT OF INTEREST. AECOM WHICH IS BEING 7 

PROPOSED TO BE GIVEN A CONTRACT IS A FUNDER OF MY WORK SO I'M 8 

GOING TO LEAVE THE MEETING. I WILL LOG BACK ON AFTER THIS ITEM 9 

IS OVER.  10 

 11 

AMY R. WORTH, CHAIR: THANK YOU NICK. ARE THERE ANY OTHER 12 

COMMITTEE MEMBERS WHO HAVE ANY QUESTIONS? ALL RIGHT THEN I'LL 13 

TURN TO THE PUBLIC --  14 

 15 

CAROL DUTRA-VERNACI: I ACTUALLY EVEN RAISED MY HAND.  16 

 17 

AMY R. WORTH, CHAIR: I'M SORRY -- NOW I SEE IT.  18 

 19 

CAROL DUTRA-VERNACI: IN ANY CASE, FIRST OF ALL, IN TERMS OF A 20 

COMMENT, TIMING COULDN'T BE BETTER WITH THE PANDEMIC AND US 21 

TRYING TO PROTECT PEOPLE. MY QUESTION IS REGARDING -- AND I AM 22 

CERTAINLY SUPPORTIVE OF THIS -- BUT I THOUGHT I WOULD GET MORE 23 

DETAIL ON THE AMENDMENT FOR THE FUNDING FOR THE DESIGNS 24 

CHANGES ON THE SOUTHERN BRIDGES. OBVIOUSLY YOU HAVE DUMBARTON 25 
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BRIDGE WOULD BE ONE OF THE SOUTHERN BRIDGES SO I THOUGHT I 1 

WOULD ASK FOR MORE DETAIL ABOUT WHAT THAT WOULD ENTAIL.  2 

 3 

AMY R. WORTH, CHAIR: OKAY TERRIFIC. THANK YOU. ANDY, WOULD YOU 4 

LIKE TO ANSWER, RESPOND TO THAT?  5 

 6 

ANDREW FREMIER: SURE. THAT'S SIMPLE. THANK YOU FOR THE 7 

QUESTION, COMMISSIONER. YOU KNOW, SEVERAL YEARS AGO, WE HAD A 8 

FASTRAK STRATEGIC PLAN THAT REALLY CHANGED THE WAY THE PLAZA 9 

APPROACHES WORK AND THAT REQUIRED AN RETIREMENT CHANGE WHERE 10 

FASTRAK OR HOV AND BUSES WERE PRIMARILY ON THE LEFT, FASTRAK 11 

WAS PRIMARILY IN THE MIDDLE AND CASH WAS ON THE RIGHT AND THAT 12 

REQUIRED A SERIES OF STRIPING AND SIGNAGE CHANGES. THOSE ARE 13 

THE KIND OF DETAIL US THAT NEED TO MAKE ADJUSTMENTS TO WHEN 14 

YOU CHANGE THE PHYSICAL APPROACH AS THE TRAVELING PUBLIC 15 

APPROACHES THE PLAZA SO WE WANT TO MAKE SURE THAT THE SIGNING 16 

IS CONSISTENT. WE DO ANTICIPATE MULTIPLE CHANGES TO THE WAY 17 

YOU PAY, AND THAT NEEDS TO BE NOTICED. TOLL SCHEDULE NEEDS TO 18 

BE NOTICED. THERE IS POTENTIAL FOR QUITE A BIT OF STRIPING AND 19 

ALIGNMENT MOVES. WE WOULD PROBABLY CONSOLIDATE SOME OF THE 20 

TRAFFIC AND MAYBE KEEP SOME BOOTHS CLOSED BECAUSE THEY'RE NOT 21 

NECESSARY IN AN ALL ELECTRONIC ENVIRONMENT. IT'S DESIGNED TO 22 

MAKE SURE WE HAVE THE ENGINEERING DETAILS RIGHT. BECAUSE THERE 23 

IS SEVERAL APPROVALS THAT TAKE PLACE BEFORE YOU ALL CAN REALLY 24 

GIVE US THE AUTHORIZE TO MOVE TO ALL ELECTRONIC TOLLING OR 25 
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EVEN TO MORE YOU IMPROVED CASHLESS ENVIRONMENT AND THAT IS 1 

GETTING THE FINANCIALS WHICH IS A CONCERN OF CFO, AND CALTRANS 2 

APPROVAL BUT WE GENERALLY ASSOCIATE WORK WITH THOSE CHANGES IF 3 

THAT'S HELPFUL.  4 

 5 

CAROL DUTRA-VERNACI: OKAY THAT WAS GOOD INFORMATION. THANK YOU 6 

VERY MUCH ANDY.  7 

 8 

AMY R. WORTH, CHAIR: THANK YOU CAROLE FOR THAT QUESTION. YES 9 

COMMISSIONER PEDROZA? ALFREDO.  10 

 11 

ALFREDO PEDROZA: THANK YOU.  12 

 13 

AMY R. WORTH, CHAIR: VICE CHAIR PEDROZA.  14 

 15 

ALFREDO PEDROZA: AMY, GREAT PRESENTATION. REALLY GLAD WE'RE 16 

LOOKING THIS. WE KNOW WHAT THE COST TERMS ARE BUT HAVE WE 17 

QUANTIFIED THE POTENTIAL SAVINGS? I REMEMBER THE COST OF CASH 18 

HANDLING AND SO FORTH WAS THE PRETTY SIGNIFICANT. HAVE YOU 19 

DONE ANY ANALYSIS ON THAT?  20 

 21 

ANDREW FREMIER: THE STUDY THAT WE REFERRED TO THAT WE 22 

COMPLETED IN 2016 AND IT WAS APPROVED BY BATA IN 2018 HAD ALL 23 

THAT DETAIL IN IT AND I AM HAPPY TO REFRESH THE COMMISSION 24 

THROUGH SOME OF THAT INFORMATION. WE HAVE BEEN CAUTIOUS THOUGH 25 
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TO ASSUME ANY PARTICULAR SAVINGS AND HAVE PRETTY MUCH CALLED 1 

IT A WASH. WE DO ANTICIPATE THAT OVER TIME THERE WOULD LIKELY 2 

BE SOME SAVINGS, BUT YOU REALLY ARE, AS I MENTIONED A COUPLE 3 

OF TIMES, MOVING THE COLLECTORS OUT OF HARM'S WAY INTO THE 4 

BACK OFFICE. GOLDEN GATE BRIDGE HAS INDICATED THEY HAVE QUITE 5 

A BIT OF SAVINGS BUT WE'RE BEING CAUTIOUS ABOUT IT UNTIL WE 6 

UNDERSTAND IT. AND FRANKLY THE INVESTMENT IN THE CAPITAL 7 

IMPROVEMENTS IS SIGNIFICANT AND THAT WILL TAKE TIME TO ABSORB 8 

AND IT REALLY IN A LOT OF WAYS DEPENDS HOW YOU CALCULATE THE 9 

INVESTMENT BUT OUR ANALYSIS IN TERMS OF TRANSACTIONS IS 10 

ESSENTIALLY SHOWING US A WASH WITH A POTENTIAL TO SAVE A FEW 11 

BUCKS AT THE END.  12 

 13 

ALFREDO PEDROZA: I APPRECIATE IT ANDY. I -- I THINK MINIMIZING 14 

THAT IS A GREAT THING. IT IS A LONG-TERM INVESTMENT BUT IT'S 15 

GOING TO PAY OFF WITH THE INSTITUTION. THANK YOU FOR BRINGING 16 

THIS FORWARD.  17 

 18 

AMY R. WORTH, CHAIR: THANK YOU. ARE THERE ANY OTHER QUESTIONS 19 

OF THE COMMITTEE? OKAY. IF NOT, THEN I WILL MOVE IT TO OUR 20 

PUBLIC COMMENT. AND I SEE ONE SPEAKER, ALETA DUPREE. SO 21 

WELCOME. AND, LET'S SEE. COULD YOU -- WELL, LET'S SEE. THERE 22 

WE GO.  23 

 24 
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SPEAKER: THANK YOU CHAIR WORTH AND MEMBERS. ALETA DUPREE FOR 1 

THE RECORD. GOOD PRESENTATION TODAY. THERE IS LEADERSHIP IN 2 

THIS. AND THIS FORECAST TO CONTINUE, AND I KNOW THAT IT IS NOT 3 

EASY. AND I HOPE THAT THIS CRISIS WILL PASS MUCH SOONER RATHER 4 

THAN LATER SO WE CAN ALL GO BACK TO A SENSE OF NORMALCY. 5 

BECAUSE I'M LIVING AT HOME WITH THIS WONDERING WHAT'S GOING ON 6 

SO, AS PART OF KEEPING THE PUBLIC SAFE, AGAIN, I MAINTAIN THE 7 

IMPORTANCE OF NOT HAVING STOPPING IN THE TOLL PLAZA, THAT OUR 8 

TRAVELING PUBLIC SHOULD CONTINUE TO TRAVEL THROUGH THE TOLL 9 

PLAZA WITH THEIR WINDOWS CLOSED AND WITHOUT STOPPING, FOR MANY 10 

SAFETY RELATED REASONS. AND THERE ARE RISKS IN CASH HANDLING, 11 

CERTAINLY MOVING CASH OFF BOARD TO A RETAIL NETWORK WHERE 12 

CUSTOMERS CAN PAY AT THEIR SUPER MARKET OR THROUGH -- IDEALLY 13 

THROUGH KIOSKS AND VENDING MACHINES SO WE CAN REDUCE THE CLOSE 14 

INTERACTIONS THAT ARE INVOLVED THAT HAPPEN EACH EVEN IN 15 

STORIES. SO THE TECHNOLOGY FOR THAT WILL BE NEEDED TO BE 16 

UPGRADED INTO THE COMMUNITY BECAUSE SOMETIMES I HAVE CASH AND 17 

I NEED TO GET RID OF IT. COLLECTION IS AN IMPORTANT. A 18 

REASONABLE VIOLATION POLICY IS IMPORTANT. AND THE ABILITY TO 19 

INVOICE. GOLDEN GATE IS DOING THIS AND OTHER AGENCIES ARE 20 

DOING IT AND OTHER AGENCIES HAVE BROUGHT THE CASH COLLECTORS 21 

BACK AND WITHOUT PUBLIC EXPLANATION. I APPRECIATE YOUR 22 

TRANSPARENCY IN THIS MATTER AND ASK THAT YOU CONTINUE THE WORK 23 

OF KEEPING THE TOLL PLAZAS FREE OF STOPPING. THANK YOU.  24 

 25 



               July 8, 2020 

 29 

AMY R. WORTH, CHAIR: GREAT. THANK YOU. ALETA THANK YOU FOR 1 

YOUR COMMENTS.  2 

 3 

JEANNIE BRUINS: MADAM CHAIR, I WOULD BE HAPPY TO MAKE THE 4 

MOTION.  5 

 6 

AMY R. WORTH, CHAIR: OKAY. I WANT TO CONFIRM, I SEE NO OTHER 7 

HANDS RAISED FROM THE PUBLIC. DO WE HAVE ANYBODY ELSE THAT 8 

WOULD LIKE TO SPEAK FROM THE PUBLIC?  9 

 10 

CLERK OF THE BOARD: I SEE NO ADDITIONAL RAISED HANDS AND THERE 11 

WAS ONE WRITTEN PUBLIC COMMENT ALSO FROM ALETA DUPREE. IT WAS 12 

A SINGLE LETTER FOR TWO ITEM.  13 

 14 

AMY R. WORTH, CHAIR: THANK YOU SO MUCH KIMBERLY FOR FORWARDING 15 

THAT TO US. I KNOW WE'RE PUTTING ALL THE LETTERS ONLINE AND ON 16 

OUR REPORT BUT I KNOW WE'RE ABLE TO GET THAT DIRECTLY. THANK 17 

YOU SO MUCH FOR SENDING ALL OF THE CORRESPONDENCE TO US. SO 18 

I'M SORRY. I HAVE A MOTION FROM COMMISSIONER BRUINS?  19 

 20 

JEANNIE BRUINS: YES.  21 

 22 

AMY R. WORTH, CHAIR: AND THERE IS A SECOND? MAY I PLEASE -- 23 

I'LL ENTERTAIN A SECOND. LET ME JUST READ OUT THE MOTION. MAY 24 

I CONFIRM, TINA, THAT YOUR MOTION IS TO APPROVE THE CONTRACT 25 
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CHANGE ORDER WITH CONDUENT STATE AND LOCAL SOLUTIONS IN THE 1 

AMOUNT OF $10,500,000, CONTRACT AMENDMENT WITH FASTRAK PUBLIC 2 

EDUCATION FOR ALL ELECTRONIC TOLLING CARIBOU IT PUBLIC 3 

RELATIONS IN THE AMOUNT OF $990,000, PURCHASE ORDER FOR 4 

FASTRAK TOLL TAGS WITH NEOLOGY, $2,881,000, AND CONTRACT 5 

AMENDMENT FOR CIVIL DESIGN FOR ALL ELECTRONIC TOLLING FOR 6 

SOUTHERN BRIDGES AE COM TECHNICAL SERVICES IN THE AMOUNT OF 7 

$250,000. IS THAT YOUR MOTION?  8 

 9 

JEANNIE BRUINS: YES, THANK YOU CHAIR.  10 

 11 

CAROL DUTRA-VERNACI: I'LL GO AHEAD AND SECOND IT.  12 

 13 

AMY R. WORTH, CHAIR: SECOND BY DUTRA-VERNACI. BEFORE WE TAKE 14 

OUR ROLL CALL VOTE I WANT TO EXTEND GREAT APPRECIATION TO OUR 15 

BATA STAFF FOR MOVING SO QUICKLY FOR YOUR ANALYSIS OF THE 16 

OPPORTUNITIES WE HAVE, AND WHAT WE NEED TO DO TO PREPARE FOR 17 

THAT. I THINK OUR PUBLIC SPEAKERS SAID IT VERY WELL IN TERMS 18 

OF PROVIDING A SAFE ENVIRONMENT FOR OUR WORKERS AND OUR 19 

CUSTOMERS, AND WORKING OUT THE ISSUES ADHERENCE IN MAKING 20 

THESE TRANSITIONS. SO ANDY, TO YOU AND YOUR STAFF THANK YOU SO 21 

MUCH FOR MOVING THIS SO QUICKLY. AND SO SUBSTANTIVELY. YOU 22 

HAVE HELPED US UNDERSTAND WHAT WE NEED TO DO TO ACCOMPLISH 23 

THIS. SO I APPRECIATE IT A GREAT DEAL. SO WITH THAT, MAY WE 24 
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PLEASE HAVE A ROLL CALL VOTE ON THIS AMENDMENT? THESE ITEM -- 1 

THIS MOTION, PLEASE.  2 

 3 

CLERK OF THE BOARD: YES. [ROLL CALL] I'LL NOTE THAT I AM 4 

MARKING COMMISSIONER JOSEFOWITZ AS RECUSED FROM THIS ITEM.  5 

 6 

AMY R. WORTH, CHAIR: PERFECT. GREAT. ALL RIGHT. THANK YOU. 7 

THANK YOU VERY MUCH.  8 

 9 

CLERK OF THE BOARD: YOU'RE WELCOME.  10 

 11 

AMY R. WORTH, CHAIR: SO THAT MOTION PASSES UNANIMOUS WITH ONE 12 

RECUSAL. THANK YOU. IF SOMEBODY MIGHT LIKE TO TAP COMMISSIONER 13 

JOSEFOWITZ ON THE SHOULDER AND TELL HIM HE CAN COME BACK INTO 14 

THE MEETING. OUR NEXT ITEM 6A IS THE I80 EXPRESS LANES 680 15 

EXPRESS LANES MARKETING FASTRAK CAMPAIGN. I WANT TO THANK OUR 16 

BATA STAFF FOR GOING OUT INTO THE COUNTIES MEETING WITH THE 17 

TRANSPORTATION COMMITTEES THAT ARE GOING TO BE WORKING WITH 18 

OUR COMMUNITIES ON THE GROUND AS THESE PROGRAMS ARE 19 

IMPLEMENTED. WE HAD A SUCCESSFUL PRESENTATION AT CONTRA COSTA 20 

THE OTHER DAY AND I WANT TO THANK YOU ALL FOR PRESENTING THOSE 21 

AS WE ROLL OUT THIS PROGRAM. I WOULD LOVE TO TURN TO OUR STAFF 22 

MEMBER LYSA HALE WHO WILL PRESENT THIS ITEM.  23 

 24 
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LYSA HALE: THANK YOU COMMISSIONER. THE LYSA HALE WITH BATA 1 

STAFF. CAN WE GET THE PRESENTATION UP. THIS IS I-880 PUBLIC 2 

INFORMATION CAMPAIGN AND ALSO WHAT'S HAPPENING IN THE STATE 3 

ROUTE 37 EXPRESS LANES AND THE I80 CONTRA COSTA EXPRESS LANES 4 

RELATED TO CLEAN AIR VEHICLES. NEXT SLIDE. SO, ON THIS SLIDE, 5 

YOU CAN SEE SOME ARTWORK WHERE WE HAVE INTENDED TO CAPTURE THE 6 

TOP EDUCATIONAL MESSAGES THAT THE PUBLIC NEEDS TO KNOW ABOUT 7 

THIS PARTICULAR EXPRESS LANES. THIS ARTWORK WILL BE USED IN 8 

DIGITAL ADDS, SOCIAL MEDIA POSTS AND OUT OF HOME ADVERTISING 9 

BUT ALSO IN INFOGRAPHICS, NEWS LETTERS PRESENTATIONS 10 

FREQUENTLY ASKED QUESTIONS, WEB SITES AND OTHER 11 

COMMUNICATIONS. BECAUSE THERE ARE SEVERAL EXPRESS LANES IN THE 12 

BAY AREA AND CHANGES OCCURRING ON SEVERAL OF THEM THIS SUMMER 13 

THE ART WORK IS FLEXIBLE TO BE REPEATED IN DIFFERENT CORRIDORS 14 

WHILE ALSO GIVING VISUAL CLUES ABOUT WHICH LANES TO WHICH THE 15 

MESSAGING APPLIES FOR EXAMPLE, THE SHIELD FOR 880 OR 237. 16 

WHILE THE GENERAL INFORMATION CAMPAIGN FOCUSES ON TEACHING 17 

PEOPLE ABOUT THE EXPRESS LANES AND THE RULES FOR USING THEM WE 18 

NEED TO SEPARATE ADVERTISING EFFORT TO SPECIFICALLY PROMOTE 19 

THE NEED TO GET A FASTRAK TOLL TAG WE HAVE DEVELOPED A 20 

CAMPAIGN USING HUMOR TO TALK ABOUT WHAT YOU COULD USE A TOLL 21 

TAG FOR ENDING WITH THE TAG LINE "BETTER ON THE EXPRESS 22 

LANES." NEXT SLIDE. I'LL WALK YOU THROUGH THE CAMPAIGN. SO, I 23 

SHOULD NOTE THAT THIS CAMPAIGN IS STILL IN DEVELOPMENT SO THE 24 

PHOTOS ON THE SLIDE SHOULD BE CONSIDERED DRAFT. THEY'RE 25 
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EXAMPLES OF ADS THAT COULD BE USED FOR DIGITAL ADVERTISING. 1 

FOR EXAMPLE, YOU MIGHT SEE AN ADD LIKE THIS POP-UP IF YOU WERE 2 

LOOKING AT SOMETHING LIKE SF GATE. NEXT SLIDE. WE ALSO 3 

PRODUCED SOME VIDEOS THAT WILL BE AIRING ON FACEBOOK. YOU CAN 4 

SEE THERE IS SOME TEXT OVER THE PHOTO. SO THE ONE IN THE UPPER 5 

LEFT IS A MAN USING A FASTRAK TOLL TAG AS A HARMONICA WE HAVE 6 

ANOTHER ONE WHERE A WOMAN USES HER FASTRAK TOLL TAG AS 7 

DEODORANT AND HER CHILDREN THINK THAT'S WEIRD AND WE HAVE 8 

ANOTHER ONE WHERE TWO WOMEN ARE DRIVING IN A CARPOOL AND A ONE 9 

OF THEM USES FASTRAK TOLL TAG AS A COMPACT TO PUT ON HER 10 

MAKEUP. AND THE CHARGING STATIONS ON THE 680 CORRIDOR WE'LL BE 11 

USING ADS AT CHARGING STATIONS TO EDUCATE PEOPLE ABOUT HOW 12 

THEY NEED TO GET A TOLL TAG TO GET THE DISCOUNTS ON THE I -- 13 

680 CONTRA COSTA EXPRESS LANES. THE LANDING PAGE TALKS ABOUT 14 

HOW TO USE FASTRAK AND ALL THE EXPRESS LANES IN THE REGION BUT 15 

MAKES IT CLEAR THAT YOU CAN USE FASTRAK ON THE BRIDGES. WITH 16 

THAT I'M HAPPY TO TAKE COMMENTS OR QUESTIONS.  17 

 18 

AMY R. WORTH, CHAIR: LYSA THANK YOU VERY MUCH FOR YOUR 19 

PRESENTATION. DO WE HAVE ANY COMMENTS FROM OUR COMMITTEE 20 

MEMBERS? OKAY. OH WAIT. I SEE TWO -- I THINK -- OH YES. OKAY. 21 

FIRST OF ALL, ANY COMMITTEE MEMBERS. JEANNIE BRUINS. I SEE 22 

YOU. THANK YOU. WORKING THE SYSTEM HERE. TRYING TO FIGURE OUT 23 

THE RAISED HANDS.  24 

 25 
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JEANNIE BRUINS: TRYING TO MAKE SURE YOU HAVE THE RIGHT SCREEN 1 

UP AT THE RIGHT TIME.  2 

 3 

AMY R. WORTH, CHAIR: EXACTLY.  4 

 5 

JEANNIE BRUINS: FIRST OF ALL I WANT TO APPLAUD THE TEAM. I 6 

LOVE THE EDUCATION ARTWORK ON HOW THE LANE WORKS. I THINK IT'S 7 

SIMPLE. I LIKE THE USE OF GRAPHICS AND SUCH. IN TERMS OF THE 8 

ADVERTISING AND THE SENSE OF HUMOR AND SUCH IN TERMS OF TRYING 9 

TO GET PEOPLE TO GET A TAG, A FASTRAK TAG, I HAVE TO SAY I'M 10 

KIND OF LUKEWARM ON THAT. BUT JUST KIND OF LUKEWARM. I DON'T 11 

KNOW WHY, BUT IT DOESN'T SEEM TO MOVE ME. AND I'M NOT SURE HOW 12 

IT MAYBE NECESSARILY HELPS PEOPLE WHO ARE TOTALLY UNAWARE OF 13 

WHAT A TOLL TAG IS.  14 

 15 

LYSA HALE: OKAY. GOOD FEEDBACK.  16 

 17 

AMY R. WORTH, CHAIR: OKAY THANK YOU. COMMISSIONER PAPAN.  18 

 19 

GINA PAPAN: YEAH. I HAVE TO AGREE ABOUT THE CAMPAIGN AD. IT'S 20 

NOT -- MAYBE I HAVE A MORE DROLL SENSE OF HUMOR. [LAUGHTER] 21 

BUT IT'S JUST NOT -- IT'S NOT DOING IT. AND IF WE'RE TRYING TO 22 

AVOID MONEY, MAYBE YOU WOULD WANT TO DO SOMETHING WHERE, LIKE 23 

SOMEBODY IS FUMBLING WITH CASH AND IT'S SIMPLER TO GET THE 24 

FASTRAK. I JUST TONIGHT KNOW. BUT IT'S NOT EXCITING.  25 
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 1 

LYSA HALE: OKAY. THANK YOU.  2 

 3 

AMY R. WORTH, CHAIR: THAT'S GREAT. OKAY GOOD. ANY OTHER 4 

COMMENTS. IF NOT THEN I WILL MOVE TO THE PUBLIC FOR YOUR 5 

COMMENTS. AND I SEE TWO SPEAKERS. FIRST PERSON IS AMY 6 

SERGEANT. WELCOME TO THE PODIUM. WHAT? AMY SERGEANT IS GONE. 7 

OKAY. A ALETA DUPREE. WELCOME BACK TO THE PODIUM.  8 

 9 

SPEAKER: THANK YOU CHAIR WORTH. ALETA DUPREE FOR THE RECORD. 10 

GOOD PRESENTATION. EDUCATION OUTREACH IS VERY IMPORTANT AND WE 11 

WANT TO SELL SOME TOLL TAGS BECAUSE IN OUR PREVIOUS ITEM WE 12 

JUST BUDGETED FOR MORE OF THEM. I ADMIT THAT I -- I GOT -- CAN 13 

YOU HEAR ME?  14 

 15 

AMY R. WORTH, CHAIR: OH YES CAN YOU START -- YOU SAID I ADMIT 16 

AND THEN YOU DROPPED OFF.  17 

 18 

SPEAKER: YEAH. A PHONE CALL CAME IN. OKAY. I'LL START OVER. 19 

THANK YOU CHAIR WORTH. GOOD PRESENTATION. A LOT OF WORK IN THE 20 

VISIONS ARE VERY HELPFUL. I AM FOLLOWING THIS I'LL ADMIT I'M 21 

NOT BIG ON THE HUMOR ASPECTS OF IT. I WAS MAKING FRIED EGGS 22 

AND I THOUGHT I DON'T WANT ANYBODY COPYCATTING TRYING TO FRY 23 

THEIR EGGS WITH A FASTRAK TOLL TAG. I WOULD LIKE TO SEE US 24 

WORK ON THIS CAMPAIGN. I LIKE THE IDEA OF NEXT TIME AND DO IT 25 
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DIFFERENTLY. I THINK YEARS AGO I WAS ON AN EXPRESS WAY IN NEW 1 

YORK. I THINK THERE WAS A BILLBOARD THAT SAID NEXT TIME TAKE 2 

THE TRAIN, IF I REMEMBER. YOU'RE SITTING ON THE LONG ISLAND 3 

EXPRESS WAY. SOMETHING LIKE THAT WOULD HELP. THIS WILL HELP 4 

GETTING FASTRAK TAGS INTO THE PUBLIC'S HANDS WHICH THEY CAN 5 

USE ON THE BRIDGES WHICH WILL UP OUR FASTRAK PERCENTAGE. LET'S 6 

WORK ON THIS AS WELL AND HAVE A SENSE OF FUN ABOUT IT BUT WE 7 

HAVE TO BE CAREFUL WITH HUMOR BECAUSE NOT ALL OF US REALLY GET 8 

THAT. THANK YOU.  9 

 10 

AMY R. WORTH, CHAIR: OKAY. GREAT. THANK YOU SO MUCH FOR YOUR 11 

COMMEND COMMENTS AND I'LL BRING IT BACK TO THE COMMITTEE. THIS 12 

IS AN INFORMATION ITEM. AND LYSA AS YOU SAID THIS IS A 13 

CONTINUING WORK IN PROGRESS. AS YOU MENTIONED, THIS FEEDBACK 14 

IS HELPFUL FROM THE COMMITTEE.  15 

 16 

LYSA HALE: THANK YOU.  17 

 18 

JEANNIE BRUINS: CAN I MAKE ONE MORE COMMENT?  19 

 20 

AMY R. WORTH, CHAIR: OH GENE ES OF COURSE.  21 

 22 

JEANNIE BRUINS: WE DEFINITELY NEED THIS CAMPAIGN WITH THE 23 

OPENING UP OF THE EXPRESS LANES BUT THE TOLL TAG HAS MORE THAN 24 

ONE PURPOSE. AND SO, I GUESS, WHILE I SEE THE NEED FOR THE 25 
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EXPRESS LANES, I THINK THE -- THERE IS VALUE IN GETTING THIS 1 

BEYOND THAT AND WHETHER OR NOT IT'S A MATTER OF OOPS, AM I 2 

READY TO PAY? AM I IN THE LANE WRONG BECAUSE I DON'T HAVE ONE 3 

OF THESE? I DON'T KNOW. BUT THE BRIDGES END, THE EXPRESS LANES 4 

BOTH USES THERE IS A MAJOR CONVENIENCE FACTOR FOR THE PUBLIC 5 

TO GET ONE OF THESE AND I GUESS I WOULD LIKE TO SEE THAT 6 

MESSAGE ABOUT CONVENIENCE BE THERE.  7 

 8 

AMY R. WORTH, CHAIR: TERRIFIC.  9 

 10 

LYSA HALE: YES.  11 

 12 

AMY R. WORTH, CHAIR: GREAT. GOOD POINT. I DIDN'T WANT TO CUT 13 

YOU OFF. GREAT. TERRIFIC. I LOVE THE SMALL TOLL TAGS WE WENT 14 

FROM THE LARGER TAGS TO THE SMALLER TOLL TAGS AND THAT WAS A 15 

GREAT USER IMPROVEMENT. OKAY WITH THAT THEN STAFF WILL TAKE 16 

THE INPUT.  17 

 18 

SCOTT HAGGERTY: HI.  19 

 20 

AMY R. WORTH, CHAIR: OKAY CHAIR HAGGERTY?  21 

 22 

SCOTT HAGGERTY: I HATE TO PILE ON BUT I WAS GOING TO GIVE THE 23 

THOUGHTS I HAD, BECAUSE I WAS JUST GOING TO BE NICE BUT I HAVE 24 

A LOT OF MILLENNIALS THAT WORK FOR ME AND I ACTUALLY SHOWED IT 25 
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TO THEM AND THEY FELT IT WAS CHEESY. AND THE ONLY REASON I'M A 1 

LITTLE CONCERNED ABOUT THAT IS, THOSE ARE THE PEOPLE WE'RE 2 

TRYING TO GET TO. SO I THINK WE NEED TO BE COGNIZANT THAT WE 3 

MAY NOT BE HITTING ALL AGE GROUPS.  4 

 5 

LYSA HALE: THAT'S ACTUALLY GREAT FEEDBACK. THANK YOU.  6 

 7 

AMY R. WORTH, CHAIR: ALL RIGHT MR. CHAIR. THANK YOU SO MUCH. 8 

AS YOU SAID THIS IS THE GROUP. WE NEED TO REACH MILLENNIALS 9 

AND ALL THOSE USING THIS. THANK YOU. A LOT OF THEM ARE 10 

COMMUTING AND USING BRIDGES AND CAROLE, WE LIKE YOUR ASSISTANT 11 

HERE WHO HAS JOINED YOU FOR THE CALL. OKAY. I WILL TURN TO OUR 12 

COMMITTEE CLERK AND ASK IF THERE ARE ANY NAMES OR 13 

ORGANIZATIONS THAT WOULD LIKE TO PRESENT PUBLIC COMMENT TO OUR 14 

MEETING?  15 

 16 

CLERK OF THE BOARD: NO. I HAVE RECEIVED NO WRITTEN PUBLIC 17 

COMMENT.  18 

 19 

AMY R. WORTH, CHAIR: OKAY WITH THAT THEN, OUR MEETING NOW IS 20 

ADJOURNED TO THE NEXT MEETING FOR THE BATA OVERSIGHT COMMITTEE 21 

WHICH WILL BE SCHEDULED TO BE HELD ON WEDNESDAY, AUGUST 12TH. 22 

AND THE DATE -- THE LOCATION TO BE DETERMINED. EITHER IN 23 

PERSON OR VIA ZOOM. SO THANK YOU, AGAIN, THANK YOU FOR 24 

EVERYONE AND THE PUBLIC FOR PARTICIPATING IN OUR MEETING AND I 25 
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WILL PASS THE GAVEL OVER TO MY COLLEAGUE FOR THE NEXT 1 

COMMITTEE MEETING. THANK YOU SO MUCH. [ADJOURNED]  2 

 3 


